Preparing Files for the Laser Cutter
The UD/Art Laser Cutter (see a brief description here) is a tool that can be used to cut, mark and/or engrave into various
materials. The laser cutter can accept vector (line art) and/or bitmap (1-bit raster images), but knowing which to use is a
combination of artistic vision and technical knowledge. Knowing how to prepare your files for feeding into the laser cutter
software will streamline your work, and this article will provide details for doing so.

Terminology
In this section we will define some terms so that the following discussions are more clear.

Bitmap
A bitmap is an image made up of a rectangular grid monochrome dots (or pixels). Usually the dots are thought of as
being black and the lack of a dot as white. As far as the laser cutter is concerned, a dot is a spot where the laser will hit.
The laser will not hit a place without a dot. The bitmap file format also contains resolution information which indicates
how many dots fit within a given linear distance. For example, a 200 dpi (dots per inch) bitmap is meant to be
represented by dots packed close enough together to fit 200 of them in a linear inch (both horizontally and vertically).

Cut
Cutting is when the laser is used to follow a path, penetrating completely through the material. Usually the path followed
is closed so the material within the path falls out.

Engrave
Engraving is when the laser is used to mark material, column by column, with a bitmap – a grid of dots (or pixels). The
laser cutter uses the resolution information in the bitmap to know how far apart mark the dots, both within the columns and
distance between the columns. Sometimes engraving is referred to as “rastering” (even though that’s not really a word).
This word comes from computer terminology where vector artwork (see definition below) needs to be converted to dots to
be represented on a screen or printer (or laser cutter).

Mark
This is similar to cutting (see above), but the laser is set to not completely penetrate through the material. The laser
makes a visible mark along the path.

Vector
Vector artwork is made up of straight or curved paths. These types of drawings are created in software like Adobe
Illustrator. Even though most software for drawing vector artwork can produce paths with a thickness (or stroke), the laser
cutter software ignores this because the laser beam has a thin, fixed width.

What you can/cannot do with the laser cutter
The laser cutter can only burn into or through material. Also, the beam can only be made to follow straight or curved paths
or to burn a grid of dots (a bitmap image). There is no way for the laser to represent color. The laser can only cut through
certain materials (e.g. wood, cardboard, paper and plastic). Otherwise, it can only etch the surface of the material.

For the materials that the laser can cut, the laser can be adjusted for power and speed to determine how far into the
material the engraving or marking will go. Engraving deeply into the material can be done for a certain effect if desired.
There’s no point to engraving all the way through the material because it’s slower than cutting through using paths. For
example, say you wanted a 5″ square hole cut into a piece of 1/4″ plywood. It makes more sense to define a 5″ square
path to cut around versus a 5″ filled square bitmap. Both will produce a 5″ square hole in the plywood, but engraving the
hole row by row with a laser beam that’s only about .01″ thick will take much longer and will waste the wood inside the
square. That being said engraving through some materials is possible and can be done if a shape cannot be easily define
by paths.

What do you want to do?
One of the first things to think about when preparing artwork files for the laser cutter is what you want to do to the material.
In general, cutting through material requires the artwork to be in a vector format, like Adobe Illustrator or AutoCAD DXF,
because paths in the artwork are used in the laser cutter software to define laser cut paths. Paths may also be marked, if
desired.
Engraving requires a bitmap image. The grid of pixels of a bitmap will be burnt into the material column by column, and
the dots will be spaced horizontally and vertically according to the resolution information in the bitmap format.

Some guidelines
Cutting Paths – If you want to cut shapes out of the material (vector shapes/paths examples below), the shapes
must be defined in a vector format, like Adobe Illustrator or AutoCAD DXF. When the laser cutter operator imports
the file, the paths that make up your shapes will be converted to laser cut paths in the laser cutter software.

Vector Graphics Examples

Marking Paths – If you want to mark the material with the thinnest lines possible, the width of the laser beam
(approx. .012″), then designing your work in a vector format will work the best. This can even include outlining text.
Paths with a stroke (thickness)- If you want the artwork to be filled in or for line/text to have thickness, then for
the most part the artwork should be in the form of a bitmap so that it can be “rastered” into the material by the laser.
Less commonly used is the ability to define a “fill path” which is a pattern (e.g. cross hatch, spiral, etc.) that gives a
bit of the illusion of filling in but it doesn’t completely cover the inside of the surrounding path.

Raster Images- If you scanned an image, it should be black and white or close to it
because the image file needs to be converted to a 1-bit Windows bitmap (BMP) file
where you will only have black and white pixels available to you. If the image is the
entirety of what you want to apply to the material, then the BMP file can be fed
directly to the laser cutter. The resolution of the BMP file is important because of
the laser beam spot size. A good resolution to shoot for is either 100 to 200 pixels
per inch. Any lower, and you may not get a good fill. Think of the examples below
as being magnified because the laser spot size is really small (about .01″).

Circle filled as a bitmap (grid of
laser spots)

Any higher, and the laser beam spots will overlap and not really increase the quality
of the image and take much longer to run on the machine.

A word about text
Text can be handled a few ways with the laser cutter, but in
practically every scenario, it is best to convert the text (fonts) to
vector paths. This is so font availability issues and licensing are
avoided. Some fonts are not allowed to be embedded in the
artwork file. One may have special fonts that are not
universally available, so it is best to convert text to vector
paths which skips the need for the laser cutter computer to
have the fonts used in the original artwork.
Outlining text is handled simply by laser engraving the outline,
but filling in text can be handled a couple ways. To fill in text, it
can either be converted to a bitmap (a grid of black and white
pixels) or be “filled” with a laser cut path of various patterns
Circle filled with a pattern of paths
(e.g. cross hatch, grid, etc.). This fill pattern is very evident in
the final result, but that may be desired. Both of these
operations (converting to bitmap and/or defining a fill patter) may be handled in the laser
cutter software, so it is not necessary to do so in the original artwork.

Preparing an Illustrator file for the laser cutter software
This section will provide some guidelines for how you should prepare your Adobe Illustrator
vector artwork for use in the laser cutter software. Keep in mind that importing the file into
the software is just the first step in the process of generating a file with which the laser cutter
can work. Once imported, the laser cutter operator will

Too much space between
laser spots

Shapes that are to be filled will be converted to bitmaps or will be assigned machine fill paths depending on the
desired result
Assign what are called machine paths to the paths from the imported Illustrator file. You will need to know which
paths you want to cut through versus mark the surface. The paths that are intended to be cut through will happen
last. This is so that engraving and marking can happen without fear of the material shifting.

The operator will produce an output file that will be fed into the laser cutter and run.

What the laser cutter operator will need to know about your Illustrator file
In general, the laser cutter operator will need to know the following about your Illustrator file.
What shapes do you intend to fill in? How do you want them to be filled in – with a solid (bitmap) fill or do you want
a pattern fill? There are only several patterns from which to choose and they will
be quite visible in the result.
What paths do you intend to only mark into (not cut through) the material?
What paths do you intend to cut through the material?

Illustrator file design guidelines
When creating a design that you intend to use in the laser cutter, there are some
guidelines that you should follow to reduce problems and make the file easy to
import into the laser cutter software.

Laser beam spots overlapping to no
benefit

Beware of overlapping shapes/paths
In Illustrator, it’s common to use overlapping shapes to give the illusion of one complex shape because shapes
underneath can be hidden. This strategy will not work with the laser cutter because the hidden parts are seen by the laser
cutter software. The following images of ice cream cones will illustrate the problem with using overlapping shapes. The
intent is to get a shape like figure (1). It is constructed with a triangle overlapping a circle, but since the laser cutter
software ignores the fill, it doesn’t matter that one shape is overlapping another and the laser cutter will produce what is
found in figure (2). While it is possible to fix this in the laser cutter software, it is a lot more work than getting it right in
Illustrator in the first place.

Stroke thickness is ignored
In Illustrator, it is common to draw paths with a thickness. The laser cutter cannot
represent thickness in vector artwork without some additional work. In any event,
you will need to outline your strokes in Illustrator. This will produce a shape that can
later be converted to a bitmap or assigned a “fill” machine path in the laser cutter
software. You will need to decide which is appropriate for your work, but most of the
time a bitmap is chosen because it produces the most complete fill if a high enough
resolution is chosen (usually 100 dpi). In the following figure, you will see an
example of a path in Illustrator with a thick stroke. This stroke cannot be directly
represented in the laser cutter software so the stroke would need to be outlined.

Overlapping shapes example

Path with thick stroke

In the following figure, the path with thick stroke has been outlined with a new path (in Illustrator: Object (menu) -> Path > Outline Stroke). NOTE: The original path remains. Either remove it or let the laser cutter operator know to ignore it
when assigning laser paths.

Path with thick stroke that has been outlined

Save the Illustrator file in the CS2 format
The manual for the laser cutter specifies that any Illustrator file that one intends to import into the laser cutter software
should use the CS2 format.
In Illustrator, save a copy of the file you are going to submit for laser cutting by following these instructions.
1. Go to the File menu and select Save As…
2. Navigate to the location where you would like to save the file and type a name in for it.
3. Click the Save button.
4. In the Optionsbox that appears, make sure the following options are as specified.
1. The Version of the saved file should be Illustrator CS2.
2. The Create PDF Compatible File option should be checked.
3. The Embed ICC Profiles option should NOT be checked.
4. The Use Compression option should NOT be checked.
5. Click the OK button.

Preparing an image file for the laser cutter
This section provides some guidelines for preparing image file for the laser cutter.

Bitmaps ONLY
The only image format that the laser cutter accepts is the Windows Bitmap (BMP) format. The bitmap must be
monochrome (1-bit). The laser beam burns the pixels row by row in the bitmap – the laser is on for black pixels and off for
the white (background) pixels.
Images that are in other formats MUST be converted to a 1-bit Windows Bitmap.

Converting color images to 1-bit Windows Bitmaps
It is possible to convert a color image to a 1-bit Windows Bitmap. Most image editing software can handle the job. The
examples in this article will use Photoshop CS6. In general, the steps are from color image to grayscale to monochrome.
There is a large potential for quality degradation with this process, so the closer to monochrome the image is to start out
with (e.g. scanned/drawn monochrome line art) the better.

Example 1: Scanned black and white line art
In this example, we will show one way to convert a color image of black and white line artwork to a 1-bit Windows Bitmap
using Photoshop CS6.
The following picture is a full-color JPEG even though it’s essentially just a black and white drawing.
First, open the image in Photoshop. With a full color (RGB in this case) image, you cannot jump directly to a bitmap
format, but you can convert it to grayscale mode as an intermediate step. To do this, in the Image menu,
choose Mode, then Grayscale.

A scan of a black and white drawing

Image, Mode, Grayscale in Photoshop

This will remove color information from the image, but that’s ok in this case because the desired result is a black and white
bitmap, and the image was originally black lines drawn on white paper. If you are warned about this in Photoshop (see
figure below), then click the Discard button.
Next, we can change the image mode to bitmap by
clicking Image in the menu, then the Mode option,
then Bitmap….

Photoshop’s discard color information warning

Image, Mode, Bitmap in Photoshop

There are ways that Photoshop can give the illusion of gray shading when going from grayscale to monochrome, but for
this line art that illusion is not necessary because we want crisp black lines. In the dialog box that appears, you are given
the option to specify the desired resolution as well as the method for Photoshop to use to fake grays. A resolution of
between 100 and 200 should be sufficient. 200 can look better, but takes more time to engrave than 100. Choose the
“50% Threshold” method for faking grays.
Bitmap conversion options dialog
The result is a 1-bit image.
The last step is to save the image in the Windows Bitmap format.
To do so, choose File then Save As… from the menu.
In the Save As… dialog box, the BMP option should be chosen in
the Format list. Make sure that it is. Change the name, if
desired, but leave the .bmp extension. Click the Save button.

Final product, 1-bit bitmap of original image

Save As… in the Photoshop menu

Make sure that BMP is chosen in the Format list

There are some options available when saving a file in Windows Bitmap format. Make sure that Windows is chosen for
the File Format and 1 Bit is chosen for the Depth as shown in the following figure. Click the OK button to complete the
save.
The BMP file that you just saved can be fed directly into the laser cutter. Copy it to a memory stick to give to the laser
cutter operator.

BMP saving options

